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This guide provides a brief 
introduction to IBM® 
Rational® Integration Tester. It 
demonstrates some of the basic 
features of Rational Integration 
Tester, including basic GUI 
elements, synchronizing with 
WSDLs, and validating data. 

Examples in this guide are 
described using SOAP/HTTP 
(it is not possible to show 
examples using every supported 
messaging product). Regardless 
of the messaging used in your 
environment, the basic 
principles are the same and you 
should be able to relate the 
examples to your own 
environment. 
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2.1 Intended Audience 
This document is intended to be read by those with a fair understanding and exposure 
to the concepts involved in both testing and development and in enterprise 
integration. It is aimed at first-time users of IBM Rational Integration Tester, and 
those who are interested in its capabilities and ease of use. No prior knowledge of 
Rational Integration Tester is assumed. 

2.2 Scope 
This document provides a quick introduction to Rational Integration Tester. (For 
information about installing Rational Integration Tester, refer to IBM Rational 
Integration Tester Installation Guide.) 

Detailed descriptions of Rational Integration Tester features, syntax, and functionality 
can be found in IBM Rational Integration Tester Reference Guide. More detailed examples 
for specific messaging systems can be found the various plugin guides that are 
provided with Rational Integration Tester. 

2.3 Typographical Conventions 
The following typographical conventions are observed throughout this document: 

Type	 Usage 

Constant Width	 Program output, listings of code examples, file names, 
commands, options, configuration file parameters, and literal 
programming elements in running text. 

Italic	 Document title names in statements that refer you to other 
documents. Also used to highlight concepts when first introduced. 

Bold	 Menu items in graphical user interface windows (such as 
Microsoft Windows-based or UNIX X Window applications) from 
which you select options or execute macros and functions. 

Submenus and options of a menu item are indicated with a 
“greater than” sign, such as Menu > Submenu or Menu > 
Option. 

2.4 Contacting IBM Support 
To contact IBM Support, see: www.ibm.com/contact/us/en/ 
 © Copyright IBM Corp. 2001, 2012 vi 
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This chapter describes how to 
start using Rational Integration 
Tester, including some 
prerequisite tasks. 
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1.1 Prerequisites 
Before you can start using Rational Integration Tester, the product must be installed 
and the project database must be created – IBM DB2, Microsoft SQL Server, 
MySQL, and Oracle are supported. 

For more information about both of these tasks, refer to IBM Rational Integration Tester 
Installation Guide. 
 © Copyright IBM Corp. 2001, 2012 2 



 

 

 

 

 

 

1.2 Starting Rational Integration Tester 
On a computer running Microsoft Windows, you can use any of the following 
methods to launch Rational Integration Tester: 

• Click  Start > (All) Programs > IBM Rational Integration Tester. 

•	 Double-click the Rational Integration Tester shortcut on the desktop. 

•	 On the Run dialog box (click Start > Run): 

- Enter the full path to the Rational Integration Tester application (for example, 
C:\Program Files\IBM\RationalIntegrationTester\
GHTester.exe) and click OK. 

Or 

- Click  Browse to locate the Rational Integration Tester application, select it, 
then click OK. 

•	 Open a command prompt and: 

- Enter the full path to the Rational Integration Tester application, for example: 
C:\Program Files\IBM\RationalIntegrationTester\ghtester.exe 

Or 

- Change to the Rational Integration Tester installation directory and enter 
ghtester.exe (or just ghtester). 

•	 Using Windows Explorer, browse to the Rational Integration Tester installation 
directory and double-click GHTester.exe. 

When Rational Integration Tester starts, the Welcome screen is displayed. 
 © Copyright IBM Corp. 2001, 2012 3 
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1.3 Creating a New Project 
To create a new Rational Integration Tester project: 

1.	 On the Welcome screen, click New Project. 

2.	 Click OK. 

The Create New Project wizard is launched. 

3.	 In the Project Name field, enter a name for the new project. 

For example, for this guided tour of Rational Integration Tester, you could create a 
project called RIT Demo. 

4.	 Optional: In the Owner field, change the name of the default project owner if 
desired. 

5.	 Optional: In the Comments field, enter any desired comments. 
 © Copyright IBM Corp. 2001, 2012 5 



 

The field defaults to showing the creation date of the project. 

6.	 Optional: In the Directory field, change the project directory, which does not have 
to have the same name as the project. 

NOTE:	 If the directory does not exist, you will be prompted to create it. It is 
possible to store the project on a network drive but doing so might 
affect the overall performance of Rational Integration Tester 
adversely. 

7.	 Click Next. 

The Server Settings screen of the Create New Project wizard is displayed. 
 © Copyright IBM Corp. 2001, 2012 6 



 

 

At this point, only the Results Database settings on the upper half of the Server 
Settings screen are important because configuring a connection to the project 
database is necessary if you want to view the output of any tests that you will create 
and run. Otherwise, you can ignore the Database Provider list. 

The Rational Test Control Panel and Results Server settings on the Server Settings 
screen can be configured later. 

8.	 Conditional: In the Database Provider list, click the database management system 
that you want to use. 

Additional fields are displayed on the Server Settings screen. 
 © Copyright IBM Corp. 2001, 2012 7 



 

 

NOTE:	 For comprehensive information about creating a project results 

database, refer to IBM Rational Integration Tester Installation Guide.
 

9. Conditional: In the Database URL field, enter the address of the database. 

For example, if using MySQL, the address might be jdbc:mysql://
 

localhost:3306/ghtester1924.
 

10. Conditional: In the User Name and Password fields, enter the user name and 
password (if any) for the database. 

11. Click Test Connection to verify that the connection to the database works correctly. 

If the test is successful, a confirmation message is displayed and the schema version 
number property and its value are displayed under Property and Value, respectively. 
 © Copyright IBM Corp. 2001, 2012 8 



 12. Click Finish to close the Create New Project wizard and to complete creating your 
new project. 

The Rational Integration Tester application window is displayed. 
 © Copyright IBM Corp. 2001, 2012 9 



NOTE: For information about the Rational Integration Tester, refer to 
Working with Rational Integration Tester. 
 © Copyright IBM Corp. 2001, 2012
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This chapter describes the 
Rational Integration Tester 
interface (the Workbench) and 
the perspectives and views that 
it contains. 
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2.1 Initial View
 
After launching Rational Integration Tester for the first time and creating a new 
project, the following screen is displayed. 

This is Architecture School, one of Rational Integration Tester’s six perspectives (for 
information about perspectives, refer to Rational Integration Tester Perspectives). 
 © Copyright IBM Corp. 2001, 2012 12 



   

 

2.2 GUI Overview
 
The Rational Integration Tester workspace is a “dockable” user interface, so sub-
windows are attached or “docked” to one side of the main application window. These 
windows can be minimized automatically when not in use. To keep them fully visible, 
they may be pinned to the workspace using the button. After a window is pinned, 
it can be dragged to a different side of the workspace. 

As you drag a window around the workspace, a grey outline of the window is 
displayed to show you where the window will be placed when you release it. 

NOTE:	 If you want to restore the workspace to its default configuration, click 
Window > Reset Current Perspective on the menu bar. 

To allow more viewing space in some of the configuration windows, you have the 
option to hide sections. 
 © Copyright IBM Corp. 2001, 2012 13 



 

 

  

 

  

 

2.3 Rational Integration Tester Perspectives 
The Rational Integration Tester workspace comprises six perspectives, which can be 
selected from the Perspectives toolbar. 

The following table outlines each perspective. 

Shortcut Button Perspective Name Purpose Key 

Architecture School F7	 Enables you to define the architecture of 
the system under test, including service 
components and logical and physical 
resources. 

Requirements F8	 Enables you to create requirements, in the 
Library	 form of messages, that will help other 

users to create tests and test data more 
quickly and more accurately. 

Recording Studio F9	 Enables you to monitor systems and 
processes, and to record events that are 
captured by Rational Integration Tester. 

Test Factory F10	 Enables you to create tests and test 
resources (tests, test suites, stubs, test 
data sets). 

Test Lab F11	 Enables you to execute test resources that 
are created in the Test Factory perspective. 

Results Gallery F12	 Enables you to view historical test data and 
various reports for any stored test run. 

The following sections describe the Architecture School perspective. For detailed 
information about all of the perspectives, refer to IBM Rational Integration Tester 
Reference Guide. 
 © Copyright IBM Corp. 2001, 2012 14 



 

 

2.3.1 Architecture School 

Architecture School is the default perspective of Rational Integration Tester, and it is 
the first one displayed when the application is started. In this perspective, you build 
the system to be tested in a simple, graphical fashion. You define the logical and 
physical system components and their relationships to one another. 

You can do the following in Architecture School: 

•	 Create and edit service and infrastructure components. 

•	 Define a service component’s operations and its dependencies to other operations 
and infrastructure components. 

•	 Create and edit physical resources. 

•	 Define the bindings of infrastructure components to their physical resources for 
different testing environments. 

Architecture School contains seven views, which are accessed by named tabs at the 
bottom of the perspective: 

• Logical View  

•	 Physical View 

•	 Synchronization 

•	 Schema Library 

• Data Models  

• Rule Cache  

• Environment Tasks
 

The following sections outline these views.
 

NOTE:	 The graphics in the following sections are only examples – no items 
or data are pre-configured in Rational Integration Tester. 

selected action includes a rule, it is displayed below. The rule can be edited, and a 
description can be added if desired. 

Click Delete All to remove all rules from the selected schema. Click Delete Orphans 
to remove all rules from the selected schema that are associated with fields that no 
longer exist (due to changes to the schema). This button is only available when 
“orphaned” rules actually exist for the schema. 
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Logical View 

The Logical View displays the services and components of the system under test, and 
the dependencies between them. It enables you to look at the system in an abstract 
manner, without having to worry about the physical locations of the different parts of 
the system. 
 © Copyright IBM Corp. 2001, 2012 16 



 

    

  
 

 

   
   

    

  

The following table summarizes how to use the Logical View. 

To...	 Do this... 

Navigate the Logical View	 Use the horizontal and vertical scroll bars, or 

click the Pan cursor  and click the 
contents of the screen and move them 
around. 

Adjust the zoom level Use the zoom buttons ( and ), or hold 
down CTRL and use your mouse’s wheel 
button to vary the zoom level. 

Move any of the components or operations Ensure that the Select cursor  is active, 
around click the item to move and drag it to the 

desired location. 

Force the application organize the layout of Click Layout All Nodes  .
all components and operations 

Set the zoom level so that the entire Click Fit to Contents  . 
diagram fits inside the screen 
 © Copyright IBM Corp. 2001, 2012 17 



Physical View 

The Physical View displays available physical resources and their location within the 
enterprise. Resources in this view are organized by subnet and host. If a resource is 
not associated with a subnet or host, it will be displayed under Unconnected 
Resources. 
 © Copyright IBM Corp. 2001, 2012 18 



Synchronisation View 

The Synchronisation view enables you to add external resources to your project, view 
resources that have been added, and synchronize those resources with your local 
system. 
 © Copyright IBM Corp. 2001, 2012 19 



 

 

Schema Library View 

The Schema Library view enables you to manage and view the schemas and message 
formats that are available in your project. 

Each schema category and format is listed under its own tab on the left side of the 
view. When a category is selected, all of the schemas available in the project are 
displayed in a tree format in the view’s center frame. 

The schemas can be sorted by clicking the Namespace and Path option buttons 
above the tree view, and the types of schemas displayed (files or URLs) can be limited 
by selecting filtering options under Filters. 

For information about adding schemas, and viewing and managing schema details, 
refer to IBM Rational Integration Tester Reference Guide or IBM Rational Integration Tester 
Getting Started Guide. 
 © Copyright IBM Corp. 2001, 2012 20 



 

Data Models View 

A data model enables you to understand the data held by the system that you want to 
simulate, and it can provide persistent storage of that data. 

Rational Integration Tester provides two methods of creating a data model: 

•	 You can create a data model while creating a data model-driven stub from 
recorded events. 

•	 Alternatively, you can use the Data Model Editor to create a data model.
 

For more information about both of these methods, refer to IBM Rational Test 

Virtualization Server Reference Guide.
 

The Data Models view enables you to:
 

•	 Access the Data Model Editor to create or modify data models.
 

•	 View or delete existing data models.
 
 © Copyright IBM Corp. 2001, 2012 21 



 

 

 

Rule Cache View 

The Rule Cache view enables you to manage validation rules. 

When validation errors are repaired and cached (for information about this, refer to 
IBM Rational Integration Tester Reference Guide), the repair method is saved as a validation 
rule. These rules will be applied to the same field from which they are created when 
the same schema is in use. 

Existing rules are listed on the left side of the view, and they can be sorted by 
namespace or path by clicking on the appropriate column heading. 

NOTE:	 The same icons are used on individual fields to indicate where a rule 
has been applied and whether or not the rule is currently enabled. 

Under the Config tab on the right side of the view, the selected rule can be enabled or 
disabled by selecting or clearing the Enable rule check box. Validation actions are 
listed under the Validate tab. Actions can be created, modified, cloned, and deleted, 
the same way as in a Message Editor (for information about this, refer to IBM Rational 
 © Copyright IBM Corp. 2001, 2012 22 



 

 

Integration Tester Reference Guide). When the selected action includes a rule, it is displayed 
below. The rule can be edited, and a description can be added if desired. 

Click Delete All to remove all rules from the selected schema. Click Delete Orphans 
to remove all rules from the selected schema that are associated with fields that no 
longer exist (due to changes to the schema). (The Delete Orphans button is available 
only when “orphaned” rules actually exist for the schema.) 

For more information about rules, refer to IBM Rational Integration Tester Reference Guide 
or IBM Rational Integration Tester Getting Started Guide. 
 © Copyright IBM Corp. 2001, 2012 23 



Environment Tasks View 

The Environment Tasks view enables you to create, modify, delete, and run any 
environment tasks that must be run before a stub starts. 

For more information about environments, refer to Environments and to IBM 
Rational Test Virtualization Server Reference Guide and to IBM Rational Test Control Panel 
System Administration Guide. 
 © Copyright IBM Corp. 2001, 2012 24 



 

2.4 Environments 
An environment is a set of variables (tags) and bindings that can be used to provide 
runtime configuration settings to test resources. By creating multiple environments 
(for example, “System Test”, “UAT”, and so on), you can quickly run the same set of 
test resources against different phases of your product lifecycle. For example, 
environment tags can be used to modify messaging settings, such as port numbers. 

By default, a new Rational Integration Tester project is not an associated with an 
environment. Clicking Project > Edit Environments on the menu bar displays the 
Environments dialog box, which enables you to associate your project with an 
existing environment. 

Alternatively, if you want to create a new environment for your project, click Project 
> Create New Environment. 
 © Copyright IBM Corp. 2001, 2012 25 



  
Environment variables are referred to as tags, and are accessed by surrounding the 
name with double percent signs, for example, %%name%%. For example, if you were to 
create an HTTP transport using a port number, you might configure the connection 
setting to use %%HTTP_Port%%. If you refer to a non-existent tag, it is shown 
underlined: %UnknownTag%%. 

The configuration of bindings in an environment, which define the relationship 
between logical and physical components in the project, is described in IBM Rational 
Integration Tester Getting Started Guide and IBM Rational Integration Tester Reference Guide. 
 © Copyright IBM Corp. 2001, 2012 26 



Testing a Web Service 
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This chapter describes how to 
import a WSDL into Rational 
Integration Tester, and how to 
create and run tests based on 
the operations and input 
parameters defined in the
WSDL. 
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3.1 Synchronizing With WSDLs 
In Rational Integration Tester, synchronization enables you to add external resources 
to your project and create automatically all of the artefacts that are needed to test the 
resource. 

The remainder of this document uses an example web service called “AddNumbers” 
to show various test creation capabilities of Rational Integration Tester. 

To add the AddNumbers web service to your project: 

1.	 In <Rational Integration Tester Installation 


Directory>\examples\addnumbers, run start.bat.
 

Alternatively, if Rational Integration Tester is running on Linux or Unix, run 
start.sh. 

The Add Numbers Server dialog box is displayed. 

2.	 Click Start Service. 

3.	 In Rational Integration Tester, open the Architecture School perspective and click the 
Synchronisation tab. 

4.	 Click  on the toolbar of the Synchronisation view to add a new external resource.
 

Alternatively, click Web > WSDL on the toolbar of the Synchronisation view.
 

The Create a new External Resource wizard is displayed.
 
 © Copyright IBM Corp. 2001, 2012 28 
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5. In the Type list, click WSDL.
 

The second screen of the wizard is displayed.
 
 © Copyright IBM Corp. 2001, 2012
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6. Under Configuration, click New. 

The New WSDL dialog box is displayed. 

7. Click Change to find the WSDL. 

The Select Location dialog box is displayed. 
 © Copyright IBM Corp. 2001, 2012 30 



 

 

8. Click the URL tab. 

9. In the URL field, enter the following URL: 

http://localhost:8088/addNumbers?wsdl 

NOTE:	 If you want to use an alternative WSDL and it is hosted on a 
password-protected server, you can use an existing Identity resource 
to specify the login credentials by clicking Browse (on the URL tab) 
to open the Identity Selection dialog box (for more information about 
this, refer to IBM Rational Integration Tester Reference Guide). 

10. Click OK to close the Select Location dialog box. 

11. Click OK to close the New WSDL dialog box. 

12. The information displayed on the second screen of the Create a new External 
Resource wizard is updated. 
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 13. Click Next. 

The third screen of the Create a new External Resource wizard is displayed. 

addNumbers should be displayed in the Name field. 
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14. Click the Create a new Component option button (if necessary). 

15. Click Next. 

The fourth screen of the Create a new External Resource wizard is displayed. 
 © Copyright IBM Corp. 2001, 2012 33 



 

 

16. Click the Open Synchronisation View to let me choose which items to 
synchronise option button (if necessary). 

17. Click Finish. 

The Synchronisation view is refreshed and AddNumbers artefacts are displayed. 
 © Copyright IBM Corp. 2001, 2012 34 



18. Ensure that the addNumbers check box is selected. 

19. Click the  button to create a local copy in Rational Integration Tester of the 
AddNumbers artefacts. 
 © Copyright IBM Corp. 2001, 2012 35 



 
After synchronization is complete, the status of all AddNumbers artefacts should 
change from No local copy exists to In sync. 
 © Copyright IBM Corp. 2001, 2012
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3.2 Verifying WSDL Resources 
To verify the AddNumbers web service that you have added to your project: 

1. Click the Logical View tab. 

Rational Integration Tester has created a service called addNumbers. Within the 
service, an AddNumbers service component has been created based on the port type 
in the WSDL. Within this service component, an operation called addition has been 
created based on the name of the operation in the WSDL. 

2. Clicking addition displays a dependency on the AddNumbersPort HTTP 
connection, which is highlighted by a purple arrow. 
 © Copyright IBM Corp. 2001, 2012 37 



 3. Double-click AddNumbersPort.
 

The ports’s HTTP Connection dialog box is displayed.
 
 © Copyright IBM Corp. 2001, 2012
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4. Click the Bindings tab. 

The port should be associated with the environment created by the AddNumbers 
web service. 
 © Copyright IBM Corp. 2001, 2012 39 



 

 

NOTE:	 If you are using a different web service or if you want to use a 
different environment, you will have to associate the port to the 
desired environment manually. For information about this, refer to 
IBM Rational Integration Tester Reference Guide. 

5.	 Click OK. 

6.	 Double-click addition. 

The addition operation’s Operation dialog box is displayed. 
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The dialog box enables you to view and modify the operation’s properties. For 
example, the Message Exchange Pattern tab defines the operation as a request/ 
reply and defines the schemas for the request and reply messages and the transport 
used to send the data. 

7.	 Click OK. 

8.	 Click the Physical View tab. 

The Physical View is displayed. 
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An artefact called http localhost:8088 should be displayed. This is the HTTP 
transport that Rational Integration Tester will use to send and receive messages to and 
from the AddNumbers web service. 
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3.3 Creating Tests 
Tests can be created in two ways – from scratch or with a wizard that automatically 
creates tests for you based on the containing operation’s message exchange pattern 
(MEP). Both options will be illustrated in the following sections. 

3.3.1 Creating Tests from Scratch 

Follow the steps below to create (empty) tests from scratch: 

1.	 Open the Test Factory perspective (F10). 

2.	 Right-click on the addition operation and select New > Tests > Test. 

3.	 When prompted, name the test “additionCheck”, then click OK. 

4.	 Double-click the new test in the Test Factory tree to open it for editing. 

5.	 In the additionCheck test editor on the right-hand side of the workspace, right-click 
the Test Steps phase and select New > Messaging > Send Request. 

A Send Request and Receive Reply action should be created. 

NOTE:	 Actions placed in the Initialise and Tear-down sections of a test will 
run, but these phases are only executed once when running multiple 
iterations of a test (at test startup and completion). These sections are 
typically used for one-time test operations, such as clearing database 
tables or moving files. 
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6.	 Double-click the Send Request action to open it. 

7.	 Ensure that the Transport is set to AddNumbersPort and the Formatter to HTTP 
Message. 

8. In the message configuration area, ensure that the Message Type is set to Text, then 
right-click on the text (String) node and select the Schema option. 
 © Copyright IBM Corp. 2001, 2012 44 



 9.	 In the first dialog of the Select Schema wizard, select the WSDL tab, select the 
AddNumbers WSDL and select the addition_INPUT_addition operation, then 
click Next to proceed. 

10. In the next window, ensure the Include Text nodes option is enabled (ticked) in the 
Content pane, then click Finish. 

The structure and content of the message body will be updated according to the 
selected schema. 
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11. Set the values of the arg0 and arg1 text nodes to 3 and 4 (double-click the empty field 
under the Value column and type in the values). 

12. Click OK to save your changes and close the editor. 

13. Double-click the Receive Reply action to open it and ensure Reply to is set to Send 
Request 1. 

14. Apply the same schema to the message (as described in steps 8 through 10), except 
this time choose addition__output__additionResponse operation. 

15. Enter “7” in the return element text node, which is the sum of arg0 and arg1. 

16. Click OK to save your changes and close the editor. 

17. Save the project (click or press Ctrl + S) and the test is now ready to run. 
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3.3.2 Creating Tests using MEP 

An operation's Message Exchange Pattern (MEP) defines the pattern, schema, and 
binding for messages that are exchanged by the operation. This information is used 
by the MEP wizard to quickly create tests. 

You can create a single test using an operation’s MEP, or multiple tests. The singular 
option quickly creates one test that you can populate and run, while the multiple 
option creates a number of structural tests according to content combinations that are 
based on the schemas defined in the WSDL. The MEP wizard can populate the tests 
with a variety of test data (for example, random data values, constants, regular 
expressions, and so on) that is defined by the schema. 

The following example illustrates how to use the MEP wizard. 

1. Open the Test Factory perspective (F10). 

2. Right-click on the addition operation and select New > Tests > Tests using MEP. 

The Create Tests wizard is displayed. The first window of the wizard enables you to 
configure the binding properties for the request and reply messages. 
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3. Click Next to proceed as we do not need to change the message bindings. 

The Structural Configuration screen enables you to set the number of occurrences 
for each message element (0 through n) and select the desired combination option for 
generating tests. 

• If  Minimum number of combinations is selected, at least one unique element 
will be generated in a message for each occurrence, but only enough tests will be 
generated to satisfy the highest single occurrence value (that is, if the most 
occurrences for any element is three, then three tests would be generated). 

• If  Every Combination is selected, a test will be created so that every unique 
combination of occurrences is satisfied (that is, if one element specifies two 
occurrences and another specifies three, then six tests would be generated). 

4. Leave the default number of occurrences and combination options, then click Next. 
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The Contents Configuration screen allows you to select the type of content to be 
populated in the text nodes of the message. 

5.	 For the arg0 and arg1 text fields, change the type to Constant and enter values of 
“4” and “5”, respectively. 

6.	 Click Next to proceed. 
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A summary is displayed, showing the number of tests that the wizard will create. 

7.	 For this example, select Do Nothing under With Tests to simply create the tests. 

NOTE:	 The MEP test can be added to an existing test suite or added to a new 
test suite, as described in Create a Test Suite with the MEP Test 
Wizard. 

8.	 Click Finish to close the wizard and create the tests as specified. You should see a 
new test called “Test” with pre-populated test data in the messages. 

9.	 Rename the test “additionCheckMEP” (right-click and select Rename, or select the 
test and press F2). You can double-click the new test to open it for editing. 

NOTE:	 The response message has not been populated with an expected value. 
The test repair wizard will be demonstrated in the next section to 
remedy this. 
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3.4 Running the Tests 
Tests – regardless of how they are created – are executed in the Test Lab perspective. 
This section describes how to run the two tests that were created previously. 

3.4.1 Running the additionCheck Test 

Follow the steps below to run the test made from scratch, additionCheck: 

1.	 Navigate to the original WSDL URL and ensure that the sample web service is still 
running. 

2.	 Open the Test Lab perspective (F11) and select the additionCheck test. 

3.	 Right-click the test and select Run, or press F5. 

While the test is running, the Task Monitor and Console will provide execution 
details. Once finished, the Progress bar should turn green and show “100%”, and the 
Status of the test should be “Complete”. In the Console, you should see a message 
indicating that the test has passed. 

The Task Monitor shows the status of all current and previous tests, and the Console 
displays the detailed execution results for the currently selected run. If desired, you 
can remove selected test runs from the Task Monitor with the Delete icon , or 
clear all runs with the Delete All icon . 
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3.4.2 Running the additionCheckMEP Test 

Follow the steps below to run the test made with the wizard, additionCheckMEP: 

1. Run the test in the same way as described in Running the additionCheck Test. 

The test should fail (that is, not pass validation) because the value returned in the 
response does not match the expected result – remember this value was left blank. 
The following errors should be displayed in the Console for the Receive Reply action: 

The expected value is not valid. Integer fields can only contain...
Expected value "", found value "9" (Action = "Equality") 

The test, however, can be repaired so that it passes the next time it is run. 

2. Click the "Expected value..." line to display the View Message Difference window. 

3. Select the highlighted line in the expected or received message to see error details. 

4. From the available options, select Overwrite expected field and close the window. 

NOTE:	 For information about the available repair options, refer to IBM 

Rational Integration Tester Reference Guide.
 

5. Run the test again by clicking the Launch again button  in the Task Monitor and 
the test should pass. 
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3.5 Creating Test Suites 
Test suites are used to run sets of tests and test suites. For example, if you have a set 
of regression tests to run, you can group and run them together in a single test suite. 

The following sections illustrate two different ways to create test suites: 

• Create a Test Suite Manually 

• Create a Test Suite with the MEP Test Wizard 

3.5.1 Create a Test Suite Manually 

The steps below illustrate how to create a very simple test suite that will run both of 
the tests that were created earlier. 

1. Open the Test Factory perspective (F10). 

2. Right-click on the addition operation and select New > Tests > Test Suite. 

3. When prompted, name the suite “additionCheckTestSuite”, then click OK. 

4. Double-click the new test suite to open it for editing. 

5. In the suite editing window to the right, double-click Scenario. 
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The Scenario Editor is displayed. 

6. Under the Config tab, select the addNumbers environment and click OK. 

7.	 Add the additionCheck and additionCheckMEP tests to the suite by dragging 

them from the Tests folder, or click the Add Tests icon and select the tests from 
the project resource dialog. 

8. Save the project (click or press Ctrl + S) and run the suite (right-click and select 
Run, or select and press F5). 

The Test Lab is opened and the suite is executed. The suite will run both tests, and 
you should see all three items (the suite and the two tests) pass. 
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3.5.2 Create a Test Suite with the MEP Test Wizard 

Earlier (in Creating Tests using MEP) we created a test based on an operation’s 
message exchange pattern using the MEP wizard. In the last step of the wizard, you 
have the option to simply create the tests, add the tests to an existing test suite, or 
create a new test suite that contains the created tests. 

The following steps illustrate how to create a new test suite using one or more tests 
created from MEP: 

1.	 Return to Creating Tests using MEP and carry out steps 1 through 6, then return to 
this section and proceed. 

The MEP wizard summary should be displayed, showing the number of tests that the 
wizard will create. 

2.	 Select Create new suite under With Tests to create a new test suite that contains the 
test being created (Do Nothing simply creates the tests from the MEP wizard and 
Add to suite will add the new tests to an existing test suite, selected by clicking 
Browse and selecting the desired suite). 
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3.	 Provide a name for the new suite in the Suite field. 

4.	 Enable any of the desired execution options under the suite name, as follows. 

• The  Run suite on Finish option will execute a new or existing test suite when 
the MEP wizard closes. 

• The  At the end... option will overwrite expected messages in any executed tests 
with the messages that are received. 

5.	 Click Finish to close the wizard and create the tests and test suite as specified. You 
should see a new test called “Test” and a new suite (with the name that you specified) 
containing the new test. 
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3.6 Viewing Test Reports 
The Results Gallery enables you to view summary and detailed coverage, error, and 
performance reports for tests and suites that have been executed in the project. 

NOTE:	 Test suite results can only be stored and viewed if the connection to 
the project database has been established properly. For more 
information, refer to IBM Rational Integration Tester Installation Guide. 

Follow the steps below to view reports for the suite that was executed earlier. 

1.	 Open to the Results Gallery perspective (F12). 

2.	 The additionCheckTestSuite suite should already be selected in the Resource field. 
If not, click Browse and select it from the project resource dialog. 

3.	 If the suite has been executed more than once, you can select the desired execution 
instance from the Instance field. 

4.	 Ensure that the Reports tab is selected to view a summary report of the selected suite 
and execution instance. 
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 5. Under the Resource column in the suite summary table, select the additionCheck 
test to view a detailed report of its results. 

The detailed test report is displayed, including the overall status of the test, any errors 
and warnings that were generated, execution times, and the detailed results of the 
Send Request and Receive Reply actions in the test. 
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4.1 Overview 

Data validation has been used throughout the exercises that have been illustrated in 
this guide. When validation is enabled for a selected field, the returned value is 
matched against the expected value. 

Validation can be enabled or disabled for a message field by selecting or clearing the 

check box in the column for that field, under the Config or Assert tab of the 
message editor. 

Validation can also be controlled by enabling or disabling the Equality option, under 
the Validate tab, of the field editor (available by double-clicking a message element). 
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4.2 Exercise 
The following exercises illustrates how validation can be enabled or disabled for 
individual message fields, and the effect it has on whether or not the test passes. 

1.	 Open the Test Factory perspective (F10) 

2.	 Double-click the additionCheck test to open it for editing in the Test Factory 
perspective (F10). 

3.	 Open the Receive Reply action and note the checked box in the validation column for 
the return text node. 

4.	 Change the value of the node to any other number (that is, something that does not 
equal the sum of arg0 and arg1 in the Send Request action), then click OK. 

5. Save the project (click or press Ctrl + S). 
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6. Run the additionCheck test in the addNumbers environment and the test should 
fail due to a validation error, as shown below. 

The specific error for the Receive Reply action would be something like the following: 

Expected value "99", found value "7" (Action = "Equality") 

7.	 Open the Receive Reply action again and clear the check box next to the same field to 
disable validation, or double-click the (Text) node and disable the Equality action in 
the field editor. 

NOTE:	 If desired, as illustrated previously, you can disable validation in the 
View Message Differences dialog (see Running the 
additionCheckMEP Test). 

8.	 Click OK in the Receive Reply editor to close it and save your changes. 

9.	 Run the test again in the same environment and it should pass. 

NOTE:	 In this example, the Equality action was used on a message field to 
validate the response, but numerous actions are available (for example, 
Xpath, Regex, Schema, Length, and custom validation).For more 
information about other validation options, refer to IBM Rational 
Integration Tester Reference Guide. 
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5.1 Overview 
So far, all of the data used in our example tests has been hard-coded. A more practical 
approach to testing, however, would be to decouple the tests from the data. One of 
the more common requirements of functional testing is to run a test through several 
iterations with different data being used each time. To do this, you will need to use 
test data sets. Data sets, along with the Iterate Test Data action, can be used to map 
test data into tags that are used to populate data fields in a test. 

Test data can be supplied to Rational Integration Tester from four types of sources: 

• Files (comma separated and fixed-width) 

• Microsoft Excel spreadsheets 

• Database queries 

• Directory (a set of files containing XML or other data) 
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5.2 Creating Data Sources 
For our example, we will create a comma separated file that contains the data we will 
utilize in the additionCheck test. 

1.	 Create and open a new text file and enter the following data in it: 

arg0,arg1
 

2,6
 

3,3
 

1,8
 

The fields in the first line – arg0 and arg1 – represent the column names. 

2.	 Save the file as data.txt to your local drive. 

3.	 In the Test Factory perspective (F10), right-click the addition operation and select 
New > Test Data > File Data Source from the context menu. 

4.	 Enter “addNumbers” for the data source name and click OK. The properties of the 
new data source will be opened for editing to the right. 

5.	 Click Browse next to the File Name field and select the data file you just created. 

6.	 Leave all of the other settings as they are and click Refresh at the bottom of the data 
source editor – preview of the data in the selected file is displayed. 

7.	 Click or press Ctrl + S to save the new data source. 
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5.3 Adding Log Actions to Tests 
Before configuring the test to use the new data source, we will add a Log action that 
will display the results of adding the arguments in the console. 

1. In the Test Factory perspective (F10), double-click the additionCheck test to open it. 

2.	 Right-click the Receive Reply action and select New > Flow > Log to add a log 
action. 

3. Double-click the Receive Reply action and click the Simple Editing View icon 
in the message editor. 

4.	 Double-click the Store field next to the Text field (under the return element) and 
enter “return.” 

5.	 Press Enter when finished. 

This will create a store action that will store the results of the field in a tag named 
%%return%%. 

6.	 Click OK to apply the change and close the Receive Reply action. 

7.	 To log the iterations as they are processed, open the Log step. 

8.	 Enter “The response is: ”, then right-click at the end of the line and select Insert Tag 
> Test Scope> return. 
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9.	 Now add “for iteration step” to the end of the line, then right-click at the end of the 
line and select Insert Tag > Built-In > TEST > ITERATION > NUMBER. 

The Log step should now contain the following text: The response is %%return%% 
for iteration step %%TEST/ITERATION/NUMBER%% 

10. Click OK to save the test action and return to the Test Factory. 
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5.4 Configuring Tests 
Now that the test data set is pointing to the new data source (our simple text file), we 
can configure a test to utilize the data that the source contains. 

1.	 In the Test Factory perspective (F10), double-click the additionCheckMEP test to 
open it. 

2.	 Double-click the Send Request action to open it. 

3.	 Right-click on each of the text nodes of the arg0 and arg1 elements and select 
Contents > Quick Tag – click Yes when prompted to overwrite data. 

4.	 Click OK when finished. 

5.	 Open the Receive Reply action. 

6.	 On the return text node, either disable validation or replace the Equality action with 
the Regex action and enter “\d” to match the expected result, then click OK. 
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7.	 Right-click the Test Steps phase and select New > Flow > Iterate Test Data. 

The new action should be created below the existing actions. 

8.	 Select the Send Request, Receive Reply, and Log actions (using the Ctrl or Shift key) 
and drag them on to the new Iterate Test Data action. 

The actions should now be inside the Iterate Test Data action, as shown below: 

9.	 Double-click the Iterate Test Data action to open it for editing. 

10. Under the Config tab, click Browse next to the Test data set field and select the 
addNumbers data set from the project resource tree. 

11. Select the Store tab to verify the mappings from the data set to the test tags. 

NOTE:	 The return node is unmapped since there is no such column in the 
test data set. 

12. Run the additionCheck test. 
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The Iterate Test Data action iterates through the data in the data set and substitutes 
the tags according to the defined mappings. The test should pass and the results 
should be written to the console by the Log action. 
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6.1 Overview
 

A fundamental requirement for some tests is to apply logic that tests something and 
takes alternative actions depending on the outcome. One of several built in or custom 
functions in Rational Integration Tester can be used to apply the logic, and a Decision 
action allows you to create one or more expressions that evaluate the outcome of the 
function. Two possible execution paths can be taken from the decision. 

In this chapter we will create a trivial example that will test the value contained in a tag 
and generate an output a message to the user if the value is greater than 100. The first 
part of the test will prompt the user for a value and store it in a tag. This test will use 
the User Interaction action to solicit a response from the user. User interactions can be 
useful for debugging, as you can use them to display tag values at any point during the 
execution of a test. 
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6.2 Exercise
 
The following exercise creates a new test and uses a function and the User Interaction 
action to evaluate the results of user input. 

1.	 Open the Test Factory perspective (F10). 

2.	 Click on the addition operation and create a new test called “Decision”. 

3.	 Double-click the new test to open it for editing, then right-click the Test Steps phase 
and add a User Interaction action (New > General > User Interaction). 

4.	 Double-click the new action and add the following message in the Message for user 
field: “Please enter your number” 

5.	 Tick the box next to the Request input from user option. 

6. Select the Store User Input tab and click New to add a store action. 
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7. Rename the default tag (newTag) to “number”. 

8.	 Click OK to save the changes and return to the test editor. 

9.	 Right-click the User Interaction step and add a Decision step to it (New > Flow > 
Decision). 

10. Double-click the Decision action to edit it. 
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 11. Click Add to add an expression. 

12. Right-click in the empty expression field and select the Select Function > Assertion 
> Less than option. 

13. Select the first expression and right-click to insert the number tag (Insert Tag < Test 
Scope > number). 

14. Replace the second expression with “100” and the expression should read as follows: 
lt(%%number%%,100) 

15. Add User Interaction actions to the True and False paths to display the correct 
message. 
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The completed test sequence should look as follows. 

16. Save the project (click or press Ctrl + S) and run the test. 

You will be prompted for input. 

17. Enter a number less than 100 (for example, 66) and click OK. 

The number will be evaluated and the result is displayed. 
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Glossary
 

The following table below lists some of the key terms used in this document, and 
provides a description of each. 

Term Description 

Field A bit of data constituent to a message. Most fields are scalar and 
therefore unitary, equivalent to data attributes. Vector fields are 
an aggregation of fields both scalar and vector, and are usually 
referred to as Messages. See also Message. 

Message A unit of information made up of a header consisting of meta­
information and a body consisting of the message data. 

Host The computer on which a software process runs. 

Publish-Subscribe A messaging paradigm for efficient one-to-many communication 
in which one process (the publisher) sends information to zero or 
more other processes (subscribers). 

Transport Informally, the messaging software in use. For instance, TIBCO 
EMS, TIBCO ActiveEnterprise, IBM WebSphere® MQ (JMS). 

Publishing Making a message (data) available on a message channel. 

Subscribing Receiving a stream of messages (data) on a given message 
channel. 

Server A host computer on a network shared by more than one user. 

JMS Java Message Service, a J2EE technology. Several 
implementations of JMS exist, for instance IBM MQ and TIBCO 
EMS. 

JMS Topic The JMS equivalent of a subject, used by JMS providers to 
implement Publish-Subscribe messaging paradigms. 

JMS Queue A JMS Queue is normally used for one-to-one messaging. 
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Term Description 

TIBCO Rendezvous A software toolkit for creating distributed applications that can 
inter-operate with TIBCO servers and applications on a TIBCO 
network. The product includes a communications daemon and 
APIs that define protocols for publish/subscribe and request/ 
reply data distribution and exchange. It uses the subject-based 
addressing™ messaging technique for data delivery, and defines 
rules for supported subject naming formats. 

TIBCO AE Message A TIBCO (Active Enterprise) proprietary format for messages 
contained within the TIBCO Repository 

Subject A user-defined, meaningful name for identifying messages on 
transports. For example, the subject EQ.IBM might identify all 
pricing data about IBM stocks, while EQ.IBM.N might identify price 
data from the New York Stock Exchange only. 
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Notices
 

This information was developed for products and services offered in the U.S.A. 

IBM may not offer the products, services, or features discussed in this document in 
other countries. Consult your local IBM representative for information on the 
products and services currently available in your area. Any reference to an IBM 
product, program, or service is not intended to state or imply that only that IBM 
product, program, or service may be used. Any functionally equivalent product, 
program, or service that does not infringe any IBM intellectual property right may be 
used instead. However, it is the user's responsibility to evaluate and verify the 
operation of any non-IBM product, program, or service. 

IBM may have patents or pending patent applications covering subject matter 
described in this document. The furnishing of this document does not grant you any 
license to these patents. You can send license inquiries, in writing, to: 

IBM Director of Licensing 
IBM Corporation 
North Castle Drive 
Armonk, NY 10504-1785 
U.S.A. 

For license inquiries regarding double-byte (DBCS) information, contact the IBM 
Intellectual Property Department in your country or send inquiries, in writing, to: 

Intellectual Property Licensing 
Legal and Intellectual Property Law 
IBM Japan, Ltd. 
19-21, Nihonbashi-Hakozakicho, Chuo-ku 
Tokyo 103-8510, Japan 

The following paragraph does not apply to the United Kingdom or any other 
country where such provisions are inconsistent with local law: 
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES 
THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, 
EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, 
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MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some 
states do not allow disclaimer of express or implied warranties in certain transactions, 
therefore, this statement may not apply to you. 

This information could include technical inaccuracies or typographical errors. 
Changes are periodically made to the information herein; these changes will be 
incorporated in new editions of the publication. IBM may make improvements and/ 
or changes in the product(s) and/or the program(s) described in this publication at 
any time without notice. 

IBM may use or distribute any of the information you supply in any way it believes 
appropriate without incurring any obligation to you. 

Licensees of this program who wish to have information about it for the purpose of 
enabling: (i) the exchange of information between independently created programs 
and other programs (including this one) and (ii) the mutual use of the information 
which has been exchanged, should contact: 

IBM United Kingdom Limited 
Intellectual Property Law 
Hursley Park 
Winchester 
SO21 2JN 
Hampshire 
United Kingdom 

Such information may be available, subject to appropriate terms and conditions, 
including in some cases, payment of a fee. 

The licensed program described in this document and all licensed material available 
for it are provided by IBM under terms of the IBM Customer Agreement, IBM 
International Program License Agreement or any equivalent agreement between us. 

Any performance data contained herein was determined in a controlled environment. 
Therefore, the results obtained in other operating environments may vary 
significantly. Some measurements may have been made on development-level systems 
and there is no guarantee that these measurements will be the same on generally 
available systems. Furthermore, some measurements may have been estimated 
through extrapolation. Actual results may vary. Users of this document should verify 
the applicable data for their specific environment. 

Information concerning non-IBM products was obtained from the suppliers of those 
products, their published announcements or other publicly available sources. IBM has 
not tested those products and cannot confirm the accuracy of performance, 
compatibility or any other claims related to non-IBM products. Questions on the 
 © Copyright IBM Corp. 2001, 2012 80 



capabilities of non-IBM products should be addressed to the suppliers of those 
products. 

All statements regarding IBM’s future direction or intent are subject to change or 
withdrawal without notice, and represent goals and objectives only. 

This information contains examples of data and reports used in daily business 
operations. To illustrate them as completely as possible, the examples include the 
names of individuals, companies, brands, and products. All of these names are 
fictitious and any similarity to the names and addresses used by an actual business 
enterprise is entirely coincidental. 

COPYRIGHT LICENSE: 

This information contains sample application programs in source language, which 
illustrate programming techniques on various operating platforms. You may copy, 
modify, and distribute these sample programs in any form without payment to IBM, 
for the purposes of developing, using, marketing or distributing application programs 
conforming to the application programming interface for the operating platform for 
which the sample programs are written. These examples have not been thoroughly 
tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, 
serviceability, or function of these programs. 

Each copy or any portion of these sample programs or any derivative work, must 
include a copyright notice as follows: 

© (your company name) (year). Portions of this code are derived from IBM Corp. 
Sample Programs. © Copyright IBM Corporation 2001, 2012. 

If you are viewing this information softcopy, the photographs and color illustrations 
may not appear. 
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Trademarks and service marks 
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of 
International Business Machines Corp., registered in many jurisdictions worldwide. 
Other product and service names might be trademarks of IBM or other companies. A 
current list of IBM trademarks is available on the Web at “Copyright and trademark 
information” at www.ibm.com/legal/copytrade.shtml. 

Microsoft and Windows are trademarks of Microsoft Corporation in the United 
States, other countries, or both. 

UNIX is a registered trademark of The Open Group in the United States and other 
countries. 

Java and all Java-based trademarks and logos are trademarks or registered trademarks 
of Oracle and/or its affiliates. 
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